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Before You Get Started 
 
There are a few important things to note about the DATABASICS Time system before 
you get started. 
 
 Ensure the site is under Trusted Sites. Follow the steps below to check the internet 

settings and contact the IT Help Desk (ITServiceDesk@calibresys.com) if you need 
assistance. 

o Open Internet Explorer and from the top navigation menu, go to Tools 
then select Internet Options. 

o Click on the Security tab. Click on the Trusted Sites icon, and then click on 
the Sites button. 

o In the Trusted Sites window, ensure that the DATABASICS Time/Expense 
site (https://time.calibresys.com) is listed in the text box and then click 
Add.  

o Click Close and OK to exit the window. 
 Disable all pop-up blockers for the DATABASICS Time. You will notice that many 

DATABASICS Time buttons do not work, or may simply beep if you have a pop-up 
blocker enabled. 

 Direct all computer configuration, log-in, connectivity or performance issues to 
ITServiceDesk@calibresys.com. 

 Questions about using DATABASICS Time should be sent to 
PayrollHelpDesk@calibresys.com.  

Accessing DATABASICS Time 
 
To access CALIBRE’s DATABASICS Time system, go to Time & Expense by clicking on  

 icon on CALPortal on the left side or open your web browser and go to 
https://time.calibresys.com.  
 
Logging In 
  
DATABASICS Time is “Active Directory (AD) aware.” Employees logged into the CALIBRE 
network (either direct connect or VPN) will not have to enter a password to enter 
DATABASICS. Employees off the network will have to log on using their CALIBRE 
passwords. 

• User ID:   

mailto:ITServiceDesk@calibresys.com
https://time.calibresys.com/
mailto:ITServiceDesk@calibresys.com
mailto:payrollhelpdesk@calibresys.com
https://time.calibresys.com/
https://time.calibresys.com/
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o Employees:  calibre\<CALIBRE network username> (This is your 
firstname.lastname) 

• Password: <CALIBRE network password>  
• If you require log-in assistance, contact ITServiceDesk@calibresys.com.   
• After logging on, you will be directed to the Dashboard, which contains the following 

windows: 
o Announcements: This will contain some helpful hints to navigating the 

software and other current information. Please read these on first use 
and review periodically (see Figure 1). 

o Home Menu: This includes shortcuts to Current Timesheet, My Time Off, 
Create New Expense Report, Ad Hoc Reports, etc.  The shortcuts are 
dependent on active modules, user role and application triggers (e.g. 
credit card transactions available) (see Figure 1). 

o Click on the Timesheet tab to begin a timesheet on the left side.  
 

 
 
 
 

Figure 1: Announcements Home Menu 
 
 
 
 
 
 
 
 

 

mailto:ITServiceDesk@calibresys.com
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Reporting Time  
In the menu on the top of the screen, click Timesheet. This will bring you to the My 
Timesheets Screen (see Figure 2).  
 

 
 

Figure 2: My Timesheets Screen 

The My Timesheets screen (see Figure 3) allows you to view high level data regarding 
your timesheets. By default, this screen displays the Reporting Period, Status, Total 
Hours, Total Billable, any Notices and the last time the timesheet was modified. 

The definition for each timesheet is described in the table below: 

Timesheet Status  Definition  

New Timesheet The timesheet has never been previously opened.  

Open The timesheet is currently in use or it has not been properly 
saved. 

Draft The timesheet has been started and saved, but has not yet 
been submitted 
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Released The timesheet has been released to the approval process, but 
no action has yet been taken by an approver.  

In Approval Process The approval process has begun, but is not yet complete. You 
may have resubmitted a rejected timesheet, or there may be 
another approval required. 

Released w/ no App The timesheet has been released, but there is no approver 
assigned to review or approve it.  

Rejected At least one line on the timesheet has been rejected by at least 
one approver.  

Approved All lines on the timesheet have been fully approved by all 
approvers.  

Closed The timesheet has been closed/archived and the user can no 
longer access it 

To enter time on your Timesheet, access your timesheets by clicking on the Timesheets 
link at the top of the screen. Click the period ending date of the timesheet you wish to 
add time.  

If the timesheet is new and auto-populate has been enabled, the timesheet will auto-
populate lines selected in the Favorites List (See Timesheet Favorites). Otherwise, the 
new timesheet will be blank. 

If you are accessing a timesheet you worked on previously, it will open with the data 
since you last saved the timesheet. 

If you wish to view timesheets outside of the date range displayed, you may use search 
on top of the page: 

• Enter the Start Date and End Date. 
 

• Click Search to view timesheets that satisfy the entered criteria. 

• You may select on Enable Preview icon  under Actions on the right or  

• You click on the Timesheet Report from the drop down near the printer icon .  
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Time Entry: To add time, select the entry field that corresponds to the line and date you 
want to add time. 

• Click on a timesheet period to begin entering your time.   
• Click the Add button to add the first entry for the timesheet. 
• Enter a Time Code, WBS, and your hours in the corresponding fields. 

• To look up a specific code, click on the search icon  next to the corresponding 
field. 

• To save your entry, hit the Enter button on your keyboard or you can use the save 
icon . 

• To add more lines, click the Add button. 
• When done, click on Save as Draft & Exit. 
 

 
Figure 3: My Current Timesheet Screen 

 

To begin reporting time follow the numbered steps below. 
 
1. You must first select a Time Code to identify the type of hours you are reporting. 

The default entry will be “ST” for Standard Time. This will apply to most of the time 
you charge when working a typical day.  
 
If you are charging to Administrative Leave (AT), Leave Without Pay (LWOP), or 
Personal Time Off (PT), you will need to change this code. To do so click the 
magnifying glass icon to the right of this field to view and select other Time Codes. 

In the popup window that appears, click on the select icon  (see Figure 4).  
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Figure 4: Time Code Selection Screen 
 

2. If you are charging Standard Time, you must select a project that applies to the 
hours you are reporting. If you are charging to any of the other Time Codes, you can 
skip this step and proceed to step #4. You can search your project by clicking on the 

magnifying glass icon to the right of this field.  
 
3. To search for available projects (see Figure 5), click the magnifying glass icon to the 

right of the “Project” column. In the popup window that appears in the “Find” field 
type in the first few characters of your project. In the example used in the screen 
captures to follow, we are searching for ZI000013 so we entered a search for “ZI”. 
Now click the Search button. 
Start typing the code or the name directly in the field to see the list of potential 

matches. If a match is not found click on the search icon  next to the 
corresponding field. 

• Enter search criteria in the Find field.  
• Click on the Search button 
• Click on  to drill down to the next level. 
• Click on  to select and copy the code(s) to the timesheet. 
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Figure 5: Project Search Screen with Search Results Displayed 

 

4. The results matching your search parameters will now be displayed. Use the scroll 
bars to view all of the results. Once you find the correct project, click on  to select 
to drill down to the next level. 

  
5. After you have selected the correct project, the next window to appear will display 

the task codes that are associated with this project (see Figure 6). Please note that 
the default sort sequence is by Task Name. Select ID to resort by Task ID. To select a 
task code, click  to select the Task Name. NOTE: Some projects may only have one 
task associated with them; however, you must still select a task code. 
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Figure 6: Project Code Search Screen with Project Tasks Displayed 

 

6. You will then return to the timesheet screen. Notice that the “Project” and “Task” 
fields are now populated. Click “Save”     icon to save the project (see Figure 7). 
 

 
Figure 7: Timesheet After Project & Task Codes Have Been Added 

 

7. If you are charging a normal project, you will not have to change your subaccount (in 
fact, if you change it, the system will change it back to your default subaccount 
upon Validation). For those of you charging to an indirect project (generally 
ZZ99xxxx), you change only the first digit of your subaccount to charge the pool for 
which you worked (see Figure 8). Typically, this would only apply to Directors, Vice 
Presidents, Corporate Officers, and those directed to do so by their supervisors. If 
this does not apply to you, skip this step and proceed to step #8. Please note the 
difference between charging the pool for which you worked and your default pool. It 
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is important to charge the pool(s) that you support, not the pool where you are 
located. Directors and VP’s generally support multiple pools, as they have 
employees in more than one pool, and should therefore charge multiple pools. 

 

  

Figure 8: Subaccount Pool Table 

 

8. Now you should move to the right side of the timesheet screen and enter in your 
work hours. Type in the appropriate hours for this day and project. When you click 
on another part of the screen, your current totals will appear for the project, day, 
and pay period (see Figure 9).  
Click “Save”  icon to save your entry on the current timesheet.  
 

 
Figure 9: Timesheet Displaying Project, Day, and Pay Period - Edit Screen 

 

9. CALIBRE’s standard work days are M-F, with an understanding that many do not 
work that schedule. All salaried exempt full time 40/32/20 hour employees who do 

Kim, Tyler
Add “5 Service Contract Act (SCA)”
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not complete a timesheet entry at the end of a work day will receive a timesheet 
reminder email. Timesheet Approvers for those that do not complete a timesheet 
entry by the early morning of the next day will receive an email. You can avoid these 
e-mails by reporting zero (0) hours, as shown below. 
 

10. There are numerous reasons why you may want to report zero (0) hours on a 
standard work day. Examples of these situations would include the following: 
• You have accumulated enough overtime during the month to meet the required 

hours, and choose to take an unpaid day. 
 You have an approved compressed work schedule (e.g., working 10 hour days 4 

days each week, instead of 8 hour days 5 days each week). 
 You work a full time 32-hour week schedule. 
 You work a full time 20-hour week schedule. 
 
If you want to report zero (0) hours for a standard work day, select “Notes”       icon 
in the left menu bar of your timesheet and a Timesheet Notes box will appear (see 
Figure 10). Change the Purpose to “Non-Work Day”, enter your notes, the Start 
Date, End Date and hit “Apply” (see Figure 10). This will prevent the reminder e-
mails from being sent to you and your Timesheet Approver. If you neglect to add this 
note, and you and/or your supervisor receive these e-mails, don’t worry. These e-
mails are purely for you and your Timesheet Approver’s information. There is no 
penalty as long as you are reporting your actual hours on a timely basis. 
Additionally, notes can be added to specific range of dates on any line. 

• To enter notes for specific hours, click on the note icon  for the line you wish 
to add a note. 

• In the pop up window, add the notes and select the date range this note is 
applicable. 

• Click the Save & Close button when finished. 
• To view all the notes on a timesheet, click on the Notes  tab on the left. 
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Figure 10: Timesheet Notes 

 

 
Figure 11: Timesheet Summary Note specifying Non Work Day 

 

11. If you need to add another Time Code or project to your timesheet, click Add button 
to create a new line. A new row will be added to your timesheet. Follow the steps 
above beginning with step #1. 
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12. Leave Without Pay (LWOP) 

If you add LWOP Time Code, you will require entering Notes  for the reason 
the use of LWOP hours on your timesheet.  
 
Please be aware that LWOP must be taken for eight (8) hours per day on a day in 
which the employee does not perform work and does not charge any other leave.  
 
Additionally, before the use of Leave without Pay, employees must complete a 
CALPortal Leave request on CALPortal. Once the request is submitted, it will channel 
the requests to the appropriate parties for approval and provide both HR and Payroll 
a copy of the Approval for our records. 
 
For more information, you may refer to CALIBRE P&P section 2.9 - Leave Without 
Pay.  
 

13. Admin Leave – Military Reserve Duty 

If you add Admin Leave (AT) Time Code, you will require entering Notes  for 
the reason the use of Admin Leave hours on your timesheet. 
 
Additionally, before the use of Admin Leave (AT), employees must complete a 
CALPortal Leave request on CALPortal. Once the request is submitted, it will channel 
the requests to the appropriate parties for approval and provide both HR and Payroll 
a copy of the Approval for our records. 
 
CALIBRE P&P section 4.11 – Administrative Leave allows 4 hours of Admin Leave per 
full day (8 hours) of Military Reserve Duty. The balance can be recorded as either 
PT or LWOP. If you elect to record LWOP, you will have to stagger the days, as 
LWOP may only be charged for eight (8) hours per day on a day in which the 
employee does not perform work and does not charge any other leave. In other 
words, for a two day Reserve Duty, charge 8 hours each day; one day to Admin 
Leave, and the other to LWOP. 
 

14. If you need to modify a line, click on the line you wish to modify and update the 
fields you wish to modify. Click “Save”   icon to save the changes. 
 

15. If you need to remove a line, click on the line you wish to delete by clicking on it 
then click       Delete. Confirm by clicking "Yes" in the pop up box. You may provide 
correction note on the pop up box.  
 

16. To properly exit a timesheet, choose one of the following options: 
• Exit Without Save: Exits the timesheet and does not save any changes made 

during that session. You may select  icon on the top left.  

https://leave.calportal.calibresys.com/default.aspx
https://calportal.calibresys.com/CALDocs/Corporate%20Info/CALIBRE_PandP.pdf
https://calportal.calibresys.com/CALDocs/Corporate%20Info/CALIBRE_PandP.pdf
https://leave.calportal.calibresys.com/default.aspx
https://calportal.calibresys.com/CALDocs/Corporate%20Info/CALIBRE_PandP.pdf
https://calportal.calibresys.com/CALDocs/Corporate%20Info/CALIBRE_PandP.pdf
Kim, Tyler
Link doesn’t work

Kim, Tyler
Ditto
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• Save As Draft & Exit: Saves the timesheet and allows you to return to 
continue from the same point (NOTE: Once you save and exit from the 
screen, you will be prompted to enter an explanatory note anytime you 
attempt to modify hours for prior days). 

 
• Submit: Begins the submission process to release the timesheet to 

approvers.  
 

17. Click Sign Out on the drop down arrow in the upper right corner of the screen to log 
out of the system. (NOTE: Closing the browser window prior to selecting one of these 
3 options will result in the timesheet being stuck in the "Open" status. The system 
will behave as if you are still accessing the timesheet and will prevent any other 
users from accessing it) (see Figure 12). 
 

 
Figure 12: Sign Out  

Closing Out Your Timesheet for a Pay Period  
 
It’s the last day of the pay period and the end of the work day. You have just input your 
hours for the day and you are ready to close out your timesheet and submit it to your 
supervisor for approval. Follow the steps below to complete this process. 
 
1. Review all hours for accuracy and correct project charges. If you make any 

corrections to previously recorded hours on your timesheet, you will be required to 
enter a note detailing why the modification was needed. 
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2. Compare your hours charged with the hours required. At the left pane of your 
timesheet, your totals will appear in bold text (see Figure 13). The following 
information is available: 
 Total Standard Hour for the month (See on the left side bottom).  
 Total Billable hours in the timesheet (See on the below timesheet).  
 Total Hours recorded for the period (See on the right top under Submit button). 

 

 
Figure 13: Timesheet Hours Totals  

 
3. Once you have completed your timesheet and are ready to submit, click Submit 

button to begin the release process.  
 

4. This will bring you to the Confirmation field (see Figure 14) 
This step ensures that the data on the timesheet is valid and will notify you if any 
policies have been violated. If a change needs to be made, select “Cancel” and 
highlight and click on the desired field and updating it. If any changes are made to 
the timesheet, you must click the Validation button in order to proceed. (NOTE: If 
you have any concerns about your required hours, project, task or subaccount 
charges, you can click Validation on the left side of the timesheet screen at any time. 
You do not have to wait until submission time.)  
 
At any time, you may click the Validation   tab to validate the timesheet. This will 
take you to the validation log where any validation errors or warnings will be 
displayed. 
 

5. Once your timesheet passed validation, click “Submit” to continue. 
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Figure 14: Timesheet Validation Confirmation Message  

 

6. This will bring you to the Confirmation field. You may select “Confirm”.  
If you wish to set the current timesheet to auto-fill any new timesheets, select the 
corresponding check box (Set this current timesheet to auto-fill next timesheet 
period). This will save all the lines with projects and hours charged to them to your 
Favorites list (See Timesheet Favorites). This will also auto-populate the next new 
timesheet you open with the lines the same lines. 

(NOTE: Only timesheet lines that have both a WBS/OBS structure and hours charged 
will be saved to your Favorites and be used to auto-populate future timesheets. Lines 
with no hours charged will not be saved or used to auto-populate a timesheet.) 

7. Your timesheet is now in your approval queue for his/her review and approval. 
 

Approval Teams 
(For Timesheet Approvers Only) 
 
Approval Teams consist of all employees whose timesheets and expense reports are 
reviewed and/or approved by one or more Approvers. Approvers can be given Approval 
or Review rights. This would allow for a Project Manager to approve all of their 
employees time and expenses, and for their Director to review, but not approve. This 
type of two tiered Approval Team would allow the Reviewer to see all members of his 
employees’ Teams, and perform Timesheet Search and reports, as explained in the 
following sections. Teams can also have multiple Approvers if the normal approver is 
not on the internet for prolonged periods. We recommend against this type of double 
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approval, as each Approver will see the timesheets in their Approval queue, which may 
cause confusion or inconsistent approvals. 
 
Reviewers and Approvers can each have email notifications turned on or off, so that 
they will receive emails alerting them that an approval is necessary, or if the employee 
does not complete their timesheet on time. Secondary Reviewers and Approvers can 
have the email disabled, but all Teams will have at least one Approver with email 
notifications. 
 
Please send your request to PayrollHelpDesk@calibresys.com to establish or make 
changes to your Approval Teams as you prefer. 

Reviewing Timesheets for your Approval Team 
(For Timesheet Approvers Only) 
 
There are several ways for supervisors to review the time that their employees are 
charging. The first is called a Timesheet Search. It allows any Reviewer or Approver to 
see each timesheet for employees in their Approval Team. It is a very useful tool to 
quickly look for timesheets that are On Hold (unsubmitted) or Released (unapproved). 
 
Within DATABASICS Time, select Admin from the main menu. From the main menu 
select Utilities. The menu option Timesheet Search will appear on the left side 
navigation bar (see Figure 15).  
 

 
 
 

 
Figure 15: DATABASICS Time Utilities Menu Showing Timesheet Search 

 
The following screen appears after click on Timesheet Search. In this example, the 
Approver has selected all On Hold (unsubmitted) timesheets for his Approval Team. This 
is the easiest way to see who hasn’t completed their timesheets on a daily basis, or who 
hasn’t submitted theirs (see Figure 16).  

mailto:PayrollHelpDesk@calibresys.com
Kim, Tyler
Is this true?
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Figure 16: DATABASICS Time Utilities – Timesheet Search Options 
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Approving or Rejecting a Timesheet  
(For Timesheet Approvers Only) 
 
Once the employees in your Approval Team(s) have submitted their timesheets, follow 
the steps below to review and approve them. 
 

1. Log in to the DATABASICS Time. Approvers have an additional menu item on the 
Dashboard called Time Approvals. Use this menu to view the reports in your 
approval bin. 

• My queue: Timesheets waiting for approval. 
• My rejections: Timesheets that you have rejected. 

 
2. The next screen to appear will display all of the staff members who have submitted 

their timesheets for approval. To view a staff member’s timesheet, click on the 
underlined link for that pay period (see Figure 17). 
 

 
Figure 17: Time Approval Screen 
 

3. The timesheet for that staff member will then display. Review the entire period for 
that timesheet by using the scroll bars (see Figure 18). Note the buttons at the top of 
the page to Approve All & Exit or Reject All & Exit.  

 

 
Figure 18: Timesheet for Approval 

 
4. To review notes from the staff member, click        Notes on the left side. Use the 

scroll bars on the timesheet to review the labor hour charges for the entire pay 
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period. After reviewing the timesheet you can approve the entire timesheet, reject 
certain lines of a timesheet, or reject the entire timesheet. Follow the steps below in 
a.-c. depending on what you want to do. 

a. To approve the entire timesheet click the Approve All & Exit button. 
i. Click on the Approve All & Exit button. A "Confirmation" window will pop up 

(see Figure 19). 
ii. Optional: Enter any notes into the field. 
iii. Click on the Finish button. 
iv. You will be taken back to the Time Approval screen. 
 

 
Figure 19: Timesheet Approval Confirmation Message 

b. To reject the entire timesheet click the Reject & Exit button. 
i. Click on the Reject & Exit button. A "Rejection Notes" window will pop up 

(see Figure 20). 
ii. Required: Enter the reason why the timesheet was rejected in the notes field. 
iii. Click on the Finish button. 
iv. You will be taken back to the Time Approval screen and the report will be 

removed from your queue. 
v. The Timesheet will be sent back to the user who submitted it with the note 

explaining why the report was rejected. 
vi. If you wish to retrieve a rejected report, use the Query feature in the Time 

Approvals menu. 
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Figure 20: Timesheet Rejection Confirmation Message 
 

c. To Approve or Reject by Line Item, right-click on the line you wish to approve or 
reject. 
i. Select either Approve (     Approve the Line) or Reject (      Reject the Line) 

from the pop up menu.  
ii. If you click Reject you will be required to enter the reason why this line is 

being rejected. 
iii. Click Save & Exit when you are done.  

 
Note: If the approver rejects individual timesheet lines, then clicks: 
• Approve & Exit: the individual line rejections will be overwritten and the 

entire timesheet will be approved. 
• Reject & Exit: The entire timesheet will be rejected and the individual line 

rejections and their messages will be saved and sent back to the  
employee that submitted the timesheet. 

 
5. Click Sign Out in the upper right corner of the screen to exit and log out of the 

system. 
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Correcting a Rejected Timesheet  
 
If your timesheet was rejected by your timesheet approver, you will be notified via 
email. To review the details of the rejection and make the appropriate corrections, 
follow the steps below. 
 
1. Login to the DATABASICS Time and you will see in Home Dashboard notice of your 

Rejected Timesheet (see Figure 21) or you may also click on Timesheets and select 
My Timesheet List from drop down menu. 

 

 
Figure 21: Dashboard Page Showing Rejected Timesheet 

 
2. The next screen will display a list of your timesheets. Under the Status column you 

will see “Rejected” next to the timesheet in question. To access the timesheet, click 
on the underlined (see Figure 22). 
 

 
Figure 22: My Timesheets Screen Showing Rejected Timesheet 

3. Your timesheet will then display. Notice that there will be a red X icon next to any 
records in your timesheet that were rejected. You can view your timesheet 
approver’s notes by clicking on this red X icon or create a Timesheet Rejection 
Report by click on icon        (see Figure 23).  
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Figure 23: Notes for Rejected Timesheet 
 

4. After reviewing the notes from your timesheet approver, make the appropriate 
corrections to your timesheet. When finished, click on icon        save, validate your 
timesheet (see Closing Out Your Timesheet for a Pay Period) and Submit. 

 
5. After confirming this is correct, you will be brought back to the My Timesheets 

screen. Notice that the status for your current timesheet has changed from 
“Rejected” to “In Approval Process” to denote you have submitted your timesheet 
for approval (see Figure 24). 
 

 
Figure 24: My Timesheets Screen Showing Rejected Timesheet Submitted for Approval 
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Print/Preview   
 

DATABASICS Timesheets may be printed in three standard print formats. View these 
reports by accessing the Print/Preview menu (see Figure 25). The Print/Preview menu is 
located on the following screens: 

• My Timesheet List 
• My Time Approval 
• Within the Timesheet itself. 

 
 

 
Figure 25: My Timesheets Screen Showing Print/Preview Option 

Standard Timesheet Print Formats 

1. Timesheet Report 
a. Displays timesheet information for selected reporting period. 
b. Breaks down Total Timesheet Hours, Total Billable Hours, and Indirect Hours. 
c. Summarizes hours by Pay Code. 

2. Adjustment Report 
a. Tracks changes to timesheet as adjustments. 

 
3. Timesheet Audit Report 

a. Shows all changes made to the timesheet. 
b. Each change is recorded with a date/time stamp along with the user who made 

the change. 
c. Corrections/modification will also appear on this report. 

http://docs.data-basics.com/confluence/display/DOCV52/Print-Preview+%28Time%29
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Leave Management (Time Off – Personal Time) 
You may review your Personal Time balance, Personal Time taken in a single location 
within your timesheet. This includes your starting balance, accrued hours, hours taken 
and ending balance for the period. 

To view your leave balance:  

1. You may click on Time Off icon on the Home Shortcuts page (see Figure 26).  

 

Figure 26: Time Off icon on the Home Shortcuts page 

2. It will show Starting Balance for the Period, Accrued Hours, Hours Taken, and 
Ending Balance for the period (see Figure 27).  

 

Figure 27: Available Leave Balance per pay period 
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3. To see your leave balance detail, you may click on any of the balances on each 
reporting period (See Figure 28). 

 

Figure 28. Running My Leave Balance Report 

 

It will create your Leave Balance Report detail for each reporting period (See Figure 29).  

  

Figure 29. My Leave Balance Report 

4. You may also view your Leave Balance Report: 

A. By clicking on View Leave Balance within your timesheet (see figure 30). 

 

Figure 30. View Leave Balance within your timesheet 
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B. By accessing the Print/Preview               drop down menu (see Figure 31) 
and select Leave Balance Report. The Print/Preview menu is located on 
the following screens: 

• My Timesheets List. 
• Within the Timesheet itself. 
• My Time Off - Personal Time page. 

 

      Figure 31.Print/Preview options for My Leave Balance Report 

 

5. You may also view your Leave Balance Report by accessing Jasper Reporting in 
DATABASICS Time and Expense by selecting Ad Hoc Reports in Home Menu and 
run Accrued Leave Balance Report (Excel) (Please refer to DATABASICS 
Reporting). 

6. To view your Approval Team’s Leave Balance, you may access Jasper Reporting in 
DATABASICS Time and Expense by selecting Ad Hoc Reports in Home Menu and 
run Accrued Leave Balance Report (Excel) and enter the Input Control by 
selecting My Team to access your Team’s Leave Balance Report (Please refer to 
DATABASICS Reporting). 
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DATABASICS Reporting 
To access the Jasper Reporting in DATABASICS Time and Expense, select  Ad Hoc 
Reports in Home Menu (Please ensure the browser’s pop-up blocker is disabled for 
DATABASICS).  

Running a Report: 
 
1. Click the View tab on the Home Page to reveal a drop down menu (see Figure 

32). 
 

 
Figure 32. Repository 
 

2. Click Repository  
3. Expand CALIBRE Systems, Inc. folder  

 

4. Expand Reports folder  
5. Click on  

a. CALIBRE User Reports (see Figure 33).    
 

 
Figure 33. CALIBRE User Reports 

 

b. CALIBRE Approver (see Figure 34) : Available only for Approvers and 
Directors and above 
 

 
Figure 34. CALIBRE Approver 

 

6. Click the Name of the report that you would like to run (see Figure 35).     
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Figure 35. CALIBRE User Reports 

 
7. Once you selected one of the report you would like to run, it will be displayed 

the options for the Input Controls and you may enter the Parameter/Input 
Controls. You must apply input values before the report can be displayed. After 
you run your report and if you would like to modify your report click on icon 
Input Controls        to modify your Parameter/Input Controls (see Figure 36 and 
Figure 37). 
 

a. For Project hours,  
i. You can select: 

a. iR-Project Summary Report or  
b. iR-Project Charge Detail Report: to see project hours 

detail day by day. 
 

ii. Select the options in the drop down menu for “Query option with 
Project” (see Figure 36). 
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Figure 36. Input Controls 

 

b. For Accrued Leave Balance: 
 

i. For your Leave Balance Report or your Team Leave Balance 
Report, you may select Accrued Leave Balance Report (Excel) and 
you may select the options in the drop down menu for the report 
option (see Figure 37). 
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Figure 37. Time Off-Personal Time Input Controls 

 
ii. For Directors and above, you may also select Accrued Leave 

Balance Report (Excel Dir/Div) (see Figure 38). 
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Figure 38. Input Controls 

 

8. Once the Parameter/Input Controls information is completed, you may click 
“Ok”. 

9. The chosen report will be displayed. 
10. You may click on icon       to export your report by select one of the available 

formats.  
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Timesheet Favorites  
 
Favorites allow you to save frequently used Projects/Tasks combinations without having 
to re-key the same codes into the timesheet each reporting period. Once saved, you can 
copy these lines into a timesheet from your favorites. To view your list of favorites, click 
the Favorites tab from the timesheet entry screen (see Figure 39).  
 

 
Figure 39. Timesheet Favorites 

 

1. Adding Lines to Your Favorites – To manually add individual lines from your 
timesheet to your favorites. 

• To save a WBS/OBS code, click the Favorites  tab. 
• Select the line on the timesheet and click the Add to Favorites  button . The 

lines will appear below. 

 
2. Searching your Favorites – You can search your favorites list by using the search 

field. 

• Select which field you would like to search against. The available fields are 
determined during configuration. You can only search against the fields that are 
enabled on the timesheet. 

• Click the Search button to search your Favorites. 

3. Adding Lines From Favorites – To manually add individual lines to your timesheet 
from your favorites: 

• To copy a WBS/OBS line from the template onto the timesheet, click on the 
Favorites tab. 

http://docs.data-basics.com/confluence/display/DOCV52/Favorites+%28Timesheet%29
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• Click the Add to Timesheet icon  to add the line to the timesheet. 
 

4. Deleting Lines from Your Favorites – To remove a line from your favorites: 

• Click the icon to remove the line from your favorites. 
  

5. Auto-Populating Your Timesheet 

You can also add all of the lines on your timesheet to your favorites upon submission of 
the report. During the submission process, select "Set current lines with Hours > 0 to 
Auto-fill any new timesheets." This will save all the lines with hours charged to them to 
your Favorites list. This will also auto-populate the next new timesheet you open with 
the lines the same lines. 

Notes: Only timesheet lines that have both a WBS/OBS structure and hours charged will 
be saved to your Favorites and be used to auto-populate future timesheets. Lines with 
no hours charged will not be saved or used to auto-populate a timesheet. 

Auto-fill only works when the status of the timesheet you are opening is "New." It will 
not auto-populate a timesheet that has been previously worked on. 

 
DATABASICS Time Preferences  
You can set your Time Preferences by click on the drop down arrow next to your name 
on right top side and select My Preferences. You will need to log out and log back in to 
see the changes. 

User Preferences 

• Time code: Select the default Pay code to be used when adding a new line. 
• Auto scroll to today's date: If "Yes" is selected, the application will scroll to 

today's date when the timesheet is opened, a new line is created or a line is 
being modified. 

• Auto populate lines from the Favorites for new timesheets: If "Yes" is selected, 
timesheet lines that are saved in your favorites will be pre-filled when you open 
a new timesheet. 

• Copy lines to Favorites on timesheet release: If "Yes" is selected, the lines on 
the timesheet you are submitting will be saved to your favorites. 

• Timesheet WBS/OBS Width (10-70%): Select the percentage of the screen to be 
devoted to the WBS/OBS portion of the timesheet. 

• My Day Starts at: The time you start your work day. 
• My Day Ends at: The time your work day ends. 
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• Display Time In and Out in AM/PM: If "Yes" is selected, you will see time in 
AM/PM format vs military time. 

• Enable SubAccount: Check “Yes” to show SubAccount. 
• Enable location: Check “Yes” to show location. 

 
 

DATABASICS Time Icon Legend 

Icon  Name  Description  

 

Add Add Entry 

 

Add to Favorites Add entry to Favorites template 

 

Add to Timesheet Add entry to timesheet from Favorites template 

 

Approve / Reject Approve and Reject Actions 

 

Attachment Attach document to the timesheet 

 

Audit Row History Display row history modification. 

 

Cancel/Undo Cancel/Undo entry edit 

 

Settings Click to go to Setting menu 

 

Delete Delete Entry 

 

Edit Make an edit to a previous entry 

 

Expand View Click on the icon to expand the viewing area. 

 

Filter  Filter timesheets 

 

Future Timesheet Future Timesheet with Time Leave Request 

 

Help Click on the icon to bring up help related to the screen the user is 
viewing. This function is maintained by individual companies. 
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Message Notification Click on the icon to add a notification. 

 

Menu of Options Click to see a menu of options applicable to the selected screen 

 

Note Add a note 

 

Note Added Icon indicates there is a note entered 

 

Posted Extracted and Posted 

 

Print Print and Preview  

 

Refresh Refresh 

 

Save Save Entry 

 

Search Icon Click on the icon to bring up the search window. 

 

Select an Option Select a  WBS option 

  
 Validation  Click to see the associated validations 

 

Validation Failed The timesheet failed validation. The timesheet cannot be 
submitted until these issues are corrected. 

 

Validation Warning There are potential errors on the timesheet. The user can still 
submit the timesheet, but should investigate the warning first. 

   Current Timesheet  Current timesheet icon on mobile app 

   Take a photo  Take photo of the document from the mobile app to attach it to 
a timesheet 

  Add Image from 
Album 

 Browse to the photo album of the mobile device to attach a 
document 

  
Add Image from the 
Repository 

 Browse to Databasics image repository to attach a document 
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